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Computer science syllabus for class III 

Lesson Title/Topic of the lesson No. of Periods 

1. Introduction to Computer 
 Definition 
 Hardware Vs Software 
 Characteristics of Computers 
 Wonders of Computers 

 

 
7 

2. Input and Output Devices 

 Input devices–Keyboard, Mouse, Joystick 
 Output devices–Monitor, Printer, Speakers 
 Types and Functions of a Keyboard 
 Types of Printers 

 

 
9 

3. Introduction to Software 
 What is a Software? 
 Types of Software–System and Application 
 Operating Systems 

 
 

6 

4. Memory 
 What is a memory? 
 Types of memory–Primary and Secondary 
 RAM and ROM 
 Memory Units 

 

 
8 

5. Multimedia and Internet 
 What is Multimedia? 
 Components used in multimedia 
 Play music and video 
 What is internet? 
 Websites 

 
 
 

5 

6. MS-Word 
 Menu and commands 
 Tools–formatting, aligning, editing 
 Formatting (Font, aligning, size etc.) 
 Bullets and numbers, Indenting 
 Creating tables 

 
 
 

7 

7. MS-Paint-Advanced 
 Tools for font, color, eraser, pencil 
 View menu, Shapes, fill, outline & Colours 
 Projects–Design of house, nature, machine etc. 

 
 

9 
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8. Programming with LOGO–Part-1 
 Home screen, Turtle 

 Logo commands–Moving, turning, pen, erase 
 Hiding and showing turtle 
 Drawing trigonometric shapes, letters etc. 

 

 
9 

Total Number of periods 60 
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Content  

 

 

Lesson  Title/Topic of the lesson  Page No  

1. Introduction to Computer  

 5 

2. Input and Output devices 

 12  

3. Introduction to software 

 21 

4. Memory 

 25  

5. Multimedia and Internet 
29  

6. Ms Word  

 35  

7. MS Paint- advance 

 48  

8. Programming with Logo –Part 1 

 59 
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CHAPTER – 1 

Introduction to Computer 

Learning Objectives 

Students will be able to:  

 Define computer 

 Differentiate between hardware and software  

 Explain various characteristics of computers 

 

 

Computer  

A Computer is an electronic machine. It runs on 

electricity. It takes inputs from users. It uses 

some program (set of instructions) to 

process these inputs. Finally it delivers 

output as per your requirement. It can also 

store your data which you can use later on. 

Hardware Vs Software 

All the parts of a computer that we can see and touch are called hardware. In other 

words, hardware are the physical parts of a computer. The basic components of the 

computer hardware are listed below: 

Monitor 

Keyboard 

Mouse 

CPU (Central Processing Unit)       

Mother Board 

RAM (Random Access Memory) 

Hard Disk Drive 

Printer 

Hello Friends! 
Let us learn few more terms related to Computers 
in this chapter. 
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Speaker etc 

 

Hardware Components of a Computer 

Software is a set of programs or a set of instructions that tell a computer 

what to do. Software are the logical parts of a computer which we can see 

or touch.   

For example: Windows Operating System, Mac OS, Android,Linux 

Antivirus, MS Paint, MS Word etc. 

 

Logos of Operating systems  

 

 

 

 

 

 

 

 

Windows Mac OS Android Linux 
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Hardware Software 

Hardware refers to the physical 
components of a computer that can 
be seen or touched 

Software refers to the logical 
components of a computer that can 
not be seen or touched 

Hardware wears out over  time Software does not  wear out over  
time 

Hardware is tangible   Software is intangible  

Examples: Monitor, Keyboard, 
Mouse, Speakers 

Examples: Operating system, MS 
Paint, MS Word 

 

Characteristics of Computers: 

Computers are used in almost every field of the modern world from online 

teaching to online ticket booking, from banking to satellite launching etc. A 

computer is capable of performing all these functions due to its 

characteristics. Some of the key characteristics are as follows: 

 Speed 

 Accuracy 

 Diligence 

 Versatility 
Storage 

1. Speed: – As you know computer can work very fast. It takes only few seconds 

for calculations that we take hours to complete. You will be surprised to know 

that computer can perform millions (1,000,000) of instructions and even more per 

second. 

Therefore, we determine the speed of computer in terms of microsecond (10-6 

part of a second) or nanosecond (10-9part of a second). From this you can imagine 

how fast your computer performs work. 

 

2. Accuracy: – The degree of accuracy of computer is very high and every 

calculation is performed with the same accuracy.  

 

 3. Diligence: – A computer is free from tiredness, lack of concentration, 

fatigue, etc. It can work for hours without committing any error. If millions 

of calculations are to be performed, a computer will perform every 
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calculation with the same accuracy.  

 

 4. Versatility: – It means the capacity to perform completely different type 

of work. You may use your computer to prepare results of your class. Next 

moment you may use it for booking of tickets or to prepare electric bills. 

 5. Storage: – Computer has the power of storing any amount 

of information or data. Any information can be stored and recalled as long as 

you require it, for any numbers of years. The Computer has an in-

built memory where it can store a large amount of data. You can also store 

data in secondary storage devices such as floppy disk, CD, Pen Drive etc. 

which can be kept outside your computer and can be carried to other 

computers. 

 

 

 

 

 

 

 

 

 

 

 

 

  

 Limitations of Computers: 

 Although a computer is a wonderful machine but it has certain limitations 

 No IQ 

 No feelings/ EQ 

 Lack of Decision Making 

Speed 

Accuracy 
Diligence 

Versatility 

Storage 

Characteristics of Computers 
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 Lack of Common Sense 

 Cannot Implement 

 Human dependency 

 

1. No IQ 

A computer cannot act on situations that are not fed or programmed into them. 

They have zero IQ (Intelligent Quotient). These outputs are completely dependent 

on the user’s input. That is they produce the wrong output if the wrong input is 

provided instead of correcting it. This is why the computer is also called the 

dump machine. 

2. No feelings/ EQ 

While the computer can work tirelessly and relentlessly. However, few tasks 

require suggestions and ideas. This can only be done if a person feels positive, 

negative, or some feeling toward the task. A computer proves unsuccessful in such 

scenarios as it does not have feelings/ EQ (Emotional Quotient). This is the biggest 

limitation of the computer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                         Limitations of Computers 

No feelings/ 

EQ 

Lack of 

Decision 

Making 

Lack of 

Common 

Sense 

Human 

dependency 

No IQ 
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3. Lack of Decision Making 

A computer cannot decide on its own. Each operation that the computer performs 

is fed with an algorithm to perform different processes for each situation. 

However, if it faces a problem that is not fed into the system, the computer is not 

ready for it. For making a decision humans have knowledge, wisdom, intelligence, 

the power to decide, etc. Computers have none of these.  

4. Lack of Common Sense 

A computer might be an automated machine still, it requires human assistance. It 

works only when it is provided with some input. For example in MS Word, 

Computer points to spelling and grammatical errors by underlining them with red 

ink. But it cannot correct it by itself.  

5. Human dependency 

A computer is a machine and is fully automated once switched on. But it cannot 

work to switch itself on. The computer also does not know when to start and when 

to stop unless it is fed with such a program. Some human assistance is always 

required in most situations. It cannot work completely on its own without human 

intervention. 

 

 

 

 

 

 

 

 

 



11 
 

EXERCISE 

Q1. Answer the following questions. 

1. A computer cannot decide on its own. Why? 

2. Differentiate between hardware and software. 

3. Explain any three characteristics of computer. 

4. List some limitations of computer. 

5. Write full form of the following- 

a) CPU = _________________________________________________________ 

b) IQ= _____________________________________________________________ 

c) RAM = __________________________________________________________ 

d) EQ = ______________________________________________________________ 

Q2. Fill in the blanks. 

 

1. A computer is an ___________________ machine. 

2. __________________ are the parts of a computer that we can see and touch. 

3. Computers have ____________ IQ. 

4. Computer is also called as ___________ machine. 

5. Computer cannot work completely on its own without ______________ 

intervention. 

Q3. Write “T” for true and ‘F’ for false for the given statements.  

1. A computer does not have feelings.   ____________ 

2. Computer points to spelling and grammatical errors by underlining 

them with blue ink.     ____________  

3. Computers have wisdom.     ____________ 

4. MS word is a hardware.     ____________ 

5. Computer takes inputs from users.    ____________ 

Q4. Complete the table with the help of the words given in the box. 

 

 

Hardware Software Storage Device 
   

Dump, human, zero, hardware, electronic 

MS paint, Speaker, CD, mouse, pen drive, keyboard, MS word, printer, 

Mac OS, floppy disk, android, DVD 
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CHAPTER – 2 

Input and output Deices 

Learning Objectives 

 Students will be able to :  

 Explain input devices  

 Identify output devices 

 Explain types and functions of Keyboard 

 List types of Printers 
 

 

As you know that a computer is a machine. It can perform many tasks at the 

same time. 

Let us take an example of a motorcycle. It has 

different parts like seat, tyres, engine, headlight etc. 

All these parts put together help the motorcycle to 

move. 

 

 

 

 

 

 

Hello  Friends.  
Now let’s learn about the different 
Input Output devices 
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The four main parts of a computer which are essential for a working system 

1. System unit  2. Monitor  3 Keyboard  4 Mouse 

  

 

 

 

 

 

 

 

 

 

 

There are many devices attached to a computer like Printer, Speaker, and 

Scanner etc. 

Broadly, computer parts are divided into the following three categories: 

 Input devices 

 Output devices 

 Processing  devices 

Let’s learn about these devices in detail 

Input devices  

The devices through which we enter data and instructions into the computer are 

called Input Devices. Input devices are hardware components that allow a user to 

interact with a computer. They come in many forms, and the type of input device 

used depends on the type of task being performed 

The three important input devices are: Keyboard, Mouse, Joystick. 

Monitor 

Keyboard 

 
 System Unit 

Mouse 
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Keyboard 

Keyboards are one of the most common types of input devices, allowing users to 

enter data into computers quickly and accurately. It is a typing device. 

 

 

 

Mouse 

The mouse is the most used pointing device. It has two 

buttons and a scroll wheel in the center.  It helps us to 

draw pictures. Using a mouse, we can point, select and 

drag any item on the monitor. While clicking and 

dragging, the mouse moves a little cursor across the 

screen 

Joystick 

A joystick is an input device that is commonly used to play 

games. It includes a base and a stick that can move to the left 

or right direction, also, it can be rotated in different 

directions. 

Output devices 

The devices which are used to show the results of input are called the output 

devices. Three commonly used output devices are Monitor, Printer, and Speaker. 

Monitor 

All that we type using the keyboard is displayed on 

Monitor. A monitor is an output device that is also 

known as a video display unit (VDU). It is used to 

display images, text, video, and graphics although it is 

almost like a TV. 
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Printer 

Printers are output devices that allow you to print results on paper. By using 

the printer we can get colored or black print outs. 

 

Speakers 

Speakers are output devices used with computer 

systems that enable us to listen to a sound as an out 

come. The sound we record from a microphone can 

be heard from the speakers. 

Types and Functions of a Keyboard: 

Types of Keyboards 

Keyboards are classified based on their mode of usage 

1. QWERTY keyboard 

Designed in the pattern of old-fashioned typewriters, QWERTY is the most 

common keyboard layout. The name comes from the order of the first 

six keys on the top left letter row of the keyboard (Q W E R T Y). The 

QWERTY keyboard layout is comfortable, familiar and time-tested, ideal for 

everyday typing needs. 

2. Wired Keyboard 

A wired keyboard means there is a wire connecting your keyboard to your 

computer. At the end of the wire is a USB plug that goes into a USB port on 

your computer. Wired keyboards are extremely reliable. 

3. Wireless Keyboard 

Wireless keyboard can be used if you connect your computer to either a 

screen or television so you can control it from the comfort of your bed or 

https://en.wikipedia.org/wiki/Computer_keyboard_keys#Types
https://en.wikipedia.org/wiki/Q
https://en.wikipedia.org/wiki/W
https://en.wikipedia.org/wiki/E
https://en.wikipedia.org/wiki/R
https://en.wikipedia.org/wiki/T
https://en.wikipedia.org/wiki/Y
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sofa. They are relatively inexpensive and very easily available. Wireless 

devices communicate using radio waves. 

4. Membrane Keyboard 

Most QWERTY computer keyboards use a single rubber-like membrane 
underneath the keys that makes contact with a circuit board when the key is 
fully depressed. 

5. Mechanical Keyboard 

Mechanical keyboards are made with high-quality plastic key switches 
underneath each of the keycaps.  

These keyboard switches are comprised of:  
Keycap: the top cap with the letter/number.  
Stem: the part underneath the keycap that moves down when pressed. 

Functions of Keyboard: 

The keys on your keyboard can be divided into several groups based on 
function: 

 Typing (Alphanumeric) keys. These keys include the same letter, 
number, punctuation, and symbol keys found on a traditional 
typewriter. 

 Control keys. These keys are used alone or in combination with other 
keys to perform certain actions. The most frequently used control keys 
are Ctrl, Alt, the Windows logo key , and Esc.  

 Function keys. The function keys are used to perform specific tasks. 
They are labeled as F1, F2, F3, and so on, up to F12. The functionality 
of these keys differs from program to program.  

 Navigation keys. These keys are used for moving around in documents 
or webpages and editing text. They include the arrow keys, Home, 
End, Page Up, Page Down, Delete, and Insert.  

 Numeric keypad. The numeric keypad is handy for entering numbers 
quickly. The keys are grouped together in a block like a conventional 
calculator or adding machine. 
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Other Functions of Keyboard 

There are various other functions of keyboard, which are given below. 

 Print Screen 

 Scroll Lock 

 Pause 

 Brightness Up & Down 

 Volume Up & Down 

Types of Printers 

Printers are output devices that allow you to print results on paper. How a 
printer prints or create graphics or text output on a paper decides its 
category. Based on the printing technology, printers are divided into two 
categories. 

 

 

 

Numeric  Keypad  Navigation Keys 

 Function Keys 

 Control Keys 

 

 Alphanumeric Keys 

Keys 
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Impact Printer 

Featuring the first category is an impact printer. It consists of one or more 
than one printing head, just like typewriters. In an impact printer, texts and 
graphics are produced on paper with the help of an ink ribbon hitting 
mechanism on paper. 

Examples of this type of printer are Dot-matrix printers, 
daisy-wheel printers, and line printers. 

 

Non-Impact Printer 

Non-impact printers work differently than 
impact printers. It produces texts and 
graphics on paper without an ink ribbon 
hitting mechanism on paper. Examples of 
this type of printer are inkjet printer and 
laser printer. 

 

Let’s understand the fundamental difference between these printers in 
brief. 

Impact Printer Non-Impact Printer 

Texts and graphics are printed on 
paper by striking 

The non-impact printer prints text 
and graphics on paper without 
striking. 

Impact printer uses electro-
mechanical devices for printing. 

The non-impact printer does not use 
it for printing. 

It makes a lot of noise. 
They are silent and make less noise 
as compared to impact printers. 

 

********************************** 
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EXERCISE 

Q1. Fill in the blanks. 

 

1) The devices through which we enter data and instruction into the 

computer are called ______________ devices. 

2) ______________ is a typing device. 

3) Wireless devices communicate using __________ waves. 

4) Mouse is a _____________ device. 

5) __________ are output devices. 

Q2. Answer the following questions. 

1) What do you understand by input and output devices? 

2) Write any three functions of keyboard. 

3) Differentiate between impact printer and non-impact printer. 

4) Write any three uses of mouse. 

5) What are the main parts of a computer which are essential for its 

working? 

Q3. Match the following. 

F1, F2, F3    alphanumeric keys 

 A, B, C, D                      control keys 

 

                                                                         Function keys 

                1, 2, 3, 4            Navigation keys 

 Ctrl             Numeric keys 

Q4. Write “T” for true and ‘F’ for false for the given statements. 

1) QWERTY is the most common keyboard layout.  __________ 

Radio, Speakers, input, pointing, keyboard 
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2) Monitor is also known as Video Display Unit.  __________ 

3) Joystick is used to display images.    __________ 

4) Laser printer is a type of impact printer.   __________ 

Q5. In the picture given below, colour the: 

 

1. Control keys in orange 

2. Navigation keys in yellow 

3. Numeric keys in green 

4. Function keys in red 

5. Alphanumeric keys in blue      
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CHAPTER – 3 

Introduction to Software 

Learning Objectives 

Students will be able to :  

 define software 

 list types of software  

 explain System software , Application software and Utility software 

 define Operating System 

 

 

Software 

Introduction 

Computer system typically consists of Hardware, Software and users. Without even one 
of these, computer cannot fulfill any task. Therefore all three components are essential 
for a working machine. It is because of software or different applications, there are 
many uses of computer.  

In the current world, modern software have surrounded us to make our lives better. 
Therefore, knowingly or unknowingly, we use different software to lead our day-to-day 
activities efficiently and more reliably. Furthermore, with time, people are becoming 
more tech-savvy. Software has such a powerful impact on our lives, but many of you 
might be thinking, "what does software means" or "what are its various types that 
exist today?". 

 It can be divided into three basic types: System Software, Application Software and 
Utility Software. 

Let's quickly discover the definition and types of software  

 

Hello  Friends.  

In this chapter, we are going to 

discuss about software 
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What is Software? 

"Software is a set of programs (sequence of instructions) that allows the users to 
perform a well-defined function or some specified task." 

Software is responsible for directing all computer-related devices and instructing them 
regarding what and how the task is to be performed. However, the software is made up 
of binary language (composed of ones and zeros), and for a programmer writing the 
binary code would be a slow and tedious task. Therefore, software programmers write 
the software program in various human-readable languages such as Java, Python, C#, 
etc.  

Types of Software 

Software's are broadly classified into two types, i.e., System Software and Application 
Software. 

1. System Software 

System software is a computer program that helps the user to run computer 
hardware or software and manages the interaction between them. Essentially, it is 
a software that constantly runs in the computer background, maintaining the 
computer hardware and computer's basic functionalities, including the operating 
system, utility software, and interface. In simple terms, you can say that the system 
software acts as a middle man that checks and facilitates the operations flowing 
between the user and the computer hardware. 

System software is an essential part of your computer system. They are the first thing 
that gets loaded in the system's memory whenever you turn on your 
computer. System software is also known as "low-level software" 

System software includes operating systems, device drivers, Firmware, libraries, 
compilers and other low-level programs that are essential for running the machine itself. 

2. Application Software 

Application software consists of programs designed to solve user problems. It provides 
users with tools necessary for completing specific tasks such as drawing using MS 
Paint, writing documents in word processor or creating spreadsheets in an Excel 
program. These programs generally come preinstalled on computers but users can also 
install new ones. They help people perform various activities ranging from simple ones 
like playing games to complex activities like data analysis and image manipulation. 

3. Utility software 

Utility software is designed to maintain system performance including optimizing disk 
space usage, cleaning up temporary files, scanning for viruses and malware etc. By 
using utility software regularly, users ensure their computers remain secure against 
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malicious threats while keeping them running at optimum speeds without any 
unnecessary clutter slowing down their systems over time. 

Some of the common examples of utility software are as follows: 

o Antivirus 

o WinRAR 

o Disk defragmenter 

o WinZip 

Operating System 

The operating system is the most prominent example of system software that acts as an 

interface between the user and system hardware. It is a group of software that 

handles the execution of programs and offers general services for the application 

that runs over the computer. 

There are several types of operating systems available for different kinds of computers 
ranging from traditional desktop machines to modern mobile phones. Popular examples 
include Windows for PCs and laptops, MacOS for Apple products like Mac Books or i 
Macs, Linux for server systems in addition to Android &iOS which run most 
smartphones today 

Some of the commonly used examples of operating systems are given below. 

o Microsoft Windows 

o Apple's iOS 

o Apple's MacOS 

o Android 

o Linux 

o Ubuntu 

o Unix 
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EXCERCISE 

Q1. Fill in the blanks. 

 

1) _______ helps us to work efficiently and more reliably. 

2) ________ is a utility software. 

3) Computer system consists of hardware, software and _______. 

4) _________ Software is also known as low-level software. 

5) Binary language is composed of ones and ________. 

Q2. Answer the following questions. 

1) What are different types of software? 

2) What is software? 

3) Differentiate between system software and application software. 

4) What do you mean by utility software? 

5) Give some examples of Operating system. 

Q3. Write ‘T’ for true and ‘F’ for false. 

1) MacOS is used in apple products .        _______  

2) Application software helps in cleaning up temporary files.  _______ 

3) Spreadsheets can be created in an Excel program.   _______ 

4) System software runs constantly in computer background.  _______ 

5) Python is not a human-readable language.    _______ 

  

 

 

 

 

 

 

 

 

 

 

WinZip, system, software, zeros, users 
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CHAPTER – 4 

Memory and its types 

Learning Objectives 

Students will be able to :  

define Memory 

list types of memory  

differentiate between RAM & ROM 

list units of memory 

 

 

Introduction 

Till class II, you must have learnt about 

various concepts in English, Hindi, 

Mathematics, Computer etc. You must be 

able to read and write alphabets, numbers 

etc. All these concepts are stored in our brain 

as a memory. A memory is the ability of a 

person to remember things. Human brain is 

super intelligent and amazing organ of our 

body. It helps us do all the calculations, make decisions, control all other organs of the 

body, store and retrieve information. The human brain can store the information in the 

brain cells in the different parts of our brain. We can also retrieve this information 

depending upon how that information is stored in our brain. 

 
In the same way, we can say that a computer also has memory. A computer memory is 
used to store data and instructions that help in the execution of various tasks and 
functions. 

 

Hello  Friends.  

In this chapter, we are going to discuss 

about Memory and its types. 
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Memory 

Computer memory is the physical storage device that allows a computer to store and 
access data, including programs and instructions.Memory is typically divided into two 
types: primary memory and secondary memory.  

 

Primary Memory: 

Primary memory is known as the main memory of the computer. Primary memory is 
located on the mother board. Primary memory allows computers to access data quickly 
and efficiently, helping them operate faster .There are two types of Primary Memory : 
RAM and ROM 

Random Access Memory ( RAM) : 

RAM is also known as volatile or temporary memory. It 
stores data temporarily while the processor is executing 
instructions. This type of storage can be accessed 
randomly by the processor without having to read through 
other stored items first. The data will be erased once the 
computer is turned off. 

Read Only Memory ( ROM) : 

The data saved on ROM is permanent. Therefore ROM 
(Read-Only Memory) is a non- volatile memory.  ROM 
holds certain instructions used during starting of 
computer. This prevents any changes from being made 
once written into ROM. In ROM the data is not lost when 
the computer is turned off. 

Secondary Memory: 

Secondary memory is also known as secondary storage. The secondary memory is 
accessed indirectly via input/output operations. This memory is also called permanent, 
external, stable or persistent memory. It is characterized by its slowness and 
cheapness, relative to the RAM, and by its permanent appearance. The Secondary 

Memory

Primary 
Memory

RAM ROM

Secondary 
memory
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memory store data that can be easily retrieved only by the main memory and used by 
the processor. It is slower than RAM but larger storage capacities than primary 
memory. 

 

We shall study more about them in class IV . 

Units of memory 

When talking about computer memory, it’s important to understand how it’s measured in 
terms of units like bytes, kilobytes, megabytes, gigabytes, terabytes, petabytes etc. A 
byte is a unit of digital information consisting of 8 bits (binary digits). Kilobyte (KB) is 
equal to 1024 bytes or 1 thousand bytes; megabyte (MB) equals 1 million bytes; 
gigabyte (GB) equals 1 billion bytes; terabyte (TB) equals 1 trillion bytes; petabyte(PB), 
exabyte(EB), zettabyte(ZB), yottabye(YB), Bronto Byte  these are all much larger than 
their preceding values with each one being 1000 times bigger than the last one 
mentioned before it. 

Computer Memory - Units of measurements 

1 Bit ( Binary Digit) Binary 0 or 1 

4 bits 1 Nibble 

8 bits 1 Byte 

1024 Bytes 1 Kilo Byte (KB) 

1024 Kilo Byte 1 Mega Byte (MB) 

1024 Mega Byte 1 Giga Byte (GB) 

1024 Giga Byte 1 Tera Byte (TB) 

1024 Tera Byte 1 Peta Byte (PB) 

1024 Peta Byte 1 Exa Byte (EB) 

1024 Exa Byte 1 Zetta Byte (ZB) 

1024 Zetta Byte 1 Yotta Byte (YB) 

1024 Yotta Byte 1 Bronto Byte 

1024 Bronto Byte  1 Geop Byte 

 

 

 

 

Secondary 
Memory

Magnetic 
Disk

Hard Disk

Optical 
Disc

CD DVD
Blu-ray 

Disc

Flash 
Drive

Pen Drive
Memory 

Card
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EXERCISE 

 

Q1. Write ‘T’ for true and ‘F’ for false. 

1) The human brain can store the information in the brain cells.      _______  

2) In RAM the data is not lost when the computer is turned off.  _______ 

3) Secondary memory is known as the main memory of the computer. _______ 

4) A byte is a unit of digital information.     _______  

Q2. Fill in the blanks. 

 

1) _________ Memory is also known as main memory of the computer. 

2) __________ is the ability to remember things. 

3) Secondary memory is also known as __________ memory.  

4) Kilobyte (KB) is equal to ______ bytes. 

5) Primary memory is located on the ____________. 

Q3. Answer the following questions. 

1) Write any three differences between RAM and ROM. 

2) Computer also has memory. Explain. 

3) Write any three examples of Secondary memory. 

4) Differentiate between primary and secondary memory. 

Q4. Complete the table. 

Computer memory units 

1 Bit ( Binary Digit) Binary 0 or 1 

4 bits  

 1 Byte 

 1 Kilobyte (KB) 

1024 Kilobyte  

 1 Gigabyte (GB) 

1024 Gigabyte  

 1 Petabyte (PB) 

1024 Petabyte  

 1 Zettabyte (ZB) 

1024 Zettabyte  

 

 

Permanent, primary, 1024, mother board, memory 
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CHAPTER – 5 

Multimedia and Internet 

Learning Objectives 

Students will be able to :  

 define Multimedia 

 list components used in multimedia   

 learn how to play music and video 

 understand about Internet and websites 

 

 

 
Introduction 

Multimedia is a term used to refer to content that combines more than one form of 
media, such as text, audio, video ,imagesand animations. It has become increasingly 
popular in recent years. Multimedia can be used for various purposes including 
entertainment, education and advertising. Common components include audio (such as 
sound effects or music), video (including live footage or animation), images (from 
photographs or illustrations) and animations (which may range from simple transitions 
between slideshows up to complex 3D models). Each type of media requires different 
techniques in terms of production and playback. 

Text 

Text is the basic components of multimedia and most common ways of communicating 
information to other person. Even though multimedia includes images, video, audio and 
graphics, Text is the basic components used in multimedia. There are two types of text : 
Static Text and Hypertext. 

Static Text 

Static text, the text or the words will remain static as a heading or in a line, or in a 

paragraph.  

Hello  Friends.  

In this chapter, we are going to discuss 

about Multimedia and Internet. 
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Hypertext  

A hypertext is a system which consists of text and the links between the text. 

Audio 

Audio is a key component of multimedia content, used to enhance the overall 
experience. There are two main types of audio: recorded sound and synthesized sound. 
Recorded sound includes anything that has been recorded onto an audio medium such 
as CDs, while synthesized sound is created using digital instruments and sequencers. 
Both can be used in multimedia projects. 

Video 

Video is a powerful tool in multimedia projects, often used to show live action or 
animation. Video is defined as the display of recorded event, scene etc. The powerful 
way to convey information in multimedia applications are embedding of video. The video 
can be categorized in two types as Analog video and Digital video.  

Images 

Images act as an vital component in multimedia. These images are generated by the 

computer in two ways, as bitmap or raster images and as vector images. 

Bitmap or Raster Images 

The common and comprehensive form of storing images in a computer is raster or 

bitmap image. Bitmap is a simple matrix of the tiny dots called pixel that forms a raster 

or bitmap image.  

Vector Images 

Drawing elements or objects such as lines, rectangles, circles and so on to create an 

images are based on Vector images. The advantage of vector image is relatively small 

amount of data is required to represent the image and thereby only less memory is 

needed to store. Various Compression formats used for this purpose are GIF, TIFF and 

JPEG. 

 

Animations 

Animation is the process displaying still images so quickly so that they give the 
impression of continuous movement. In animation the screen object is a vector image in 
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animation. There are many different types of animations that can be used depending on 
the context and desired effect; these range from simple 2D vector graphics to complex 
3D models. The two basic types of animations are Path animation and Frame 
animation. 

Play Music and Video 

 

Playing a sound, music, or other audio file in Windows requires that you use a media 
player program that can play the audio file.  

To open Windows Media Player and play the file, follow the steps 

below. 

1. Click the Start button. 

2. Go to All Apps, Windows Accessories 

3. Click Windows Media Player. 

 

 

 

Click  Music              Album                 Select the audio file to play the music 

https://www.computerhope.com/jargon/s/start.htm
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Similarly a video can be played using Windows Media player by selecting Videos from the 
library. 

 

What is Internet ? 

Internet is the foremost important tool 
and the prominent resource that is being 
used by almost every person across the 
globe. It connects millions of computers, 
web pages, websites, and servers. 
Using the internet we can send emails, 
photos, videos, messages to our loved 
ones. Or in other words, the internet is a 
widespread interconnected network of 
computers and electronics devices (that 
support internet). It creates a 
communication medium to share and 
get information online. If your device is 
connected to the Internet then only you 
will be able to access all the 
applications, websites, social media 
apps, and many more services. Internet nowadays is considered as the fastest medium 
for sending and receiving information. 
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How does the Internet works? 

The actual working of the internet takes place with the help of clients and servers. Here 
the client is a laptop that is directly connected to the internet and servers are the 
computers connected indirectly to the Internet and they are having all the websites 
stored in those large computers. These servers are connected to the internet with the 
help of ISP (Internet Service Providers) and will be identified with the IP address.  

 

Websites 

A website is a collection of many web pages, and web pages are digital files that are 
written using HTML (Hyper Text Markup Language). To make your website available to 
every person in the world, it must be stored or hosted on a computer connected to the 
Internet . Such computers are known as a Web Server. 

The website’s web pages are linked with hyperlinks and hypertext and share a common 
interface and design. The website might also contain some additional documents and 
files such as images, videos, or other digital information. Websites can be used as 
business tools, educational resources or personal platforms for individuals and 
organizations alike. 

 

There are two types of Websites  

 Static Website 
 Dynamic Website 

 

Static Website: In Static Websites, Web pages are provided by the server which prebuilt 
source code files are built using simple languages such as HTML, CSS, or JavaScript. 
There is no processing of content on the server (according to the user) in Static 
Websites.  

 

Dynamic Website: In Dynamic Websites, Web pages are returned by the server which is 
processed during runtime means they are not prebuilt web pages, but they are built 
during runtime according to the user’s demand.  
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EXERCISE 
 

Q1. Write ‘T’ for true and ‘F’ for false. 

5) Through audio we can show live action or animation.   _______  

6) ISP stands for Internet Service Products.    _______ 

7) Synthesized sound is created using digital instruments and sequencers. _______ 

8) Through internet we cannot share any information.                           _______  

 

 

Q2. Fill in the blanks. 

 

6) __________is a term used to refer more than one media. 

7) A ___________ is a system which consists of text and the links between the text. 

8) In animation the screen object is a________ image. 

9) Web pages are _______ files that are written using HTML. 

10) _________ is the process displaying still images quickly. 

Q3. Answer the following questions. 

5) Explain about any three multimedia from your daily life. 

6) What is internet? 

7) How images are generated by the computer? 

8) How does internet works? 

9) What is Web server? Name two types of websites. 

 

 

 

 

 

 

 

Animation, hypertext, multimedia, vector, digital 
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CHAPTER – 6 

MS Word 

Learning Objectives 

Students will be able to :  

 Learn various Menus  of MS Word 

 explain different tabs 

 apply formatting to text 

 create bullets and numbers 

 create table in MS Word 

 

 

 

Introduction 

Microsoft Word is word processing software. It is developed by Microsoft and is part of 

Microsoft Office Suite. It enables you to create, edit and save professional documents 

like letters and reports. 

 

Office Button : 

 

The office button is an essential element of Microsoft Office Suite 2007. This button was 

introduced in Office 2007 with the new Ribbon feature. When we click on the Office 

button, it displays some useful options to open, save, print any document, or perform 

other common functions. 

Office Button Menu Options 

Hello Friends.  

In this chapter, we are going to discuss 

about MS Word and its tools 
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The following options or commands are displayed when we click on the Office button: 

o New: This option allows us to create a new, blank file in 

the corresponding Office program, such as MS Word, MS 

Excel, PowerPoint, etc. 

o Open: This option allows us to open an existing file from 

the local storage on our computer. 

o Save: This option allows us to permanently save a 

temporary file to our computer after finishing the work.  

o Save As: This option allows us to save a copy of the active 

file with the desired file name and file extension to a 

desired location on the computer storage. 

o Print: This option allows us to take a hard copy of the 

desired document on paper through a printer. 

Prepare: This option allows us to prepare the active file for 

distribution. In particular, the prepare option helps us view 

and modify the document properties accordingly.  

o Send: This option enables us to send or share the desired 

files directly through the opened Office program with 

others. In particular, we may share active documents by e-

mail, upload them to OneDrive, or post to a specific blog.  

o Publish: This option enables us to distribute the desired document to people. We 

can even create a specific blog article with the content inside the file. 

o Close: This option helps us to close an active document in a corresponding 

Office program. 

Quick Access Toolbar 

Quick Access Toolbar lies next to the Microsoft Office Button. It is a customizable 
toolbar that comes with a set of independent commands. It gives you quick access to 
commonly used commands such as Save, Undo, Redo, etc. 
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When you click the drop-down arrow next to toolbar it offers more commands. With a 

left click you can add any of these commands to Quick Access Toolbar. You can also 

remove the commands added to the tool bar. The following image is showing the menu 

of quick access toolbar. 

 

Title Bar 

It lies next to the Quick Access Toolbar. It displays the title of the currently opened 
document. It is present on almost all windows displayed on your computer. So, if there 
are several windows across the screen, you can identify each window by looking at the 
title bar.  

 

Ribbon and Tabs 

It is located below the Quick Access Toolbar and the Title Bar. It comprises seven tabs; 
Home, Insert, Page layout, References, Mailing, Review and View. Each tab has 
specific groups of related commands. It gives you quick access to the commonly used 
commands that you need to complete a task. 

 

Home tab: 

The Home tab is the default tab in Microsoft Word. It has five groups of related 
commands; Clipboard, Font, Paragraph, Styles and Editing. It helps you change 
document settings like font size, adding bullets, adjusting styles and many other 
common features. It also helps you to return to the home section of the document. 
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Insert tab: 

Insert Tab is the second tab in the Ribbon. As the name suggests, it is used to insert or 
add extra features in your document. It is commonly used to add tables, pictures, clip 
art, shapes, page number, etc. The Insert tab has seven groups of related commands; 
Pages, Tables, Illustrations, Links, Header & Footer, Text and Symbols. 

 

Page Layout tab: 

It is the third tab in the Ribbon. This tab allows you to control the look and feel of your 
document, i.e. you can change the page size, margins, line spacing, indentation, 
documentation orientation, etc. The Page Layout tab has five groups of related 

commands; Themes, Page Setup, Page Background, Paragraph and Arrange. 

 

 

References tab: 

It is the fourth tab in the Ribbon. It allows you to enter document sources, citations, 
bibliography commands, etc. It also offers commands to create a table of contents, an 
index, table of contents and table of authorities. The References tab has six groups of 
related commands; Table of Contents, Footnotes, Citations & Bibliography, Captions, 
Index and Table of Authorities. 
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Mailings tab: 

It is the fifth tab in the ribbon. It is the least-often used tab of all the tabs available in the 
Ribbon. It allows you merge emails, writing and inserting different fields, preview results 
and convert a file into a PDF format. The Mailings tab has five groups of related 
commands; Create, Start Mail Merge, Write & Insert Fields, Preview Results and Finish. 

 

Review tab: 

It is the sixth tab in the Ribbon. This tab offers you some important commands to modify 
your document. It helps you proofread your content, to add or remove comments, track 
changes, etc. The Review tab has six groups of related commands; Proofing, 
Comments, Tracking, Changes, Compare and Protect. 

 

 

View tab: 

The View tab is located next to the Review tab. This tab allows you to switch between 
Single Page and Two Page views. It also enables you to control various layout tools like 
boundaries, guides, rulers. Its primary purpose is to offers you different ways to view 
your document. The View tab has five groups of related commands; Document Views, 
Show/Hide, Zoom, Window and Macros. 
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Ruler 

The Ruler is located below the Ribbon around the edge of the document. It is used to 
change the format of the document, i.e. it helps you align the text, tables, graphics and 
other elements of your document. It uses inches or centimeters as the measurements 
unit and gives you an idea about the size of the document. 

 

 

How to Insert Text in MS Word 

The basic steps to insert text or to create a new document in Word are listed below; 

o Go to the start menu and look for Microsoft Word icon 

o Click the icon to open the Microsoft Word 

o You will see a blinking cursor or insertion point in the text area below the ribbon 

o Now, as you start typing, the words will appear on the screen in the text area 

o To change the location of insertion point press spacebar, Enter or Tab keys 

 

 

How to Select Text in MS Word 

Place the cursor next to the text then left click the mouse and holding it down move it 

over the text then release it. The text will be selected. 
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Some shortcuts for selecting text are: 

o To select a single word double click within the word 

o To select the entire paragraph triple click within the paragraph 

o To select entire document, in Home tab, in Editing group click Select then choose 

Select All option or press CTRL+A 

 

How to Delete Text in MS Word 

You can easily delete the text in Word including characters, paragraphs or all of the 
content of your document. Word offers you different methods to delete the text; some of 
the commonly used methods are given below; 

o Place the cursor next to the text then press Backspace key 

o Place the cursor to the left of the text then press Delete key 

o Select the text and press the Backspace or Delete key 

o Select the text and type over it the new text. 

 

How to Change Font Size in MS Word 

You can easily change the font size of your text in the document. The basic steps to 
change the Font size are listed below; 

o Select the text that you want to modify 

o In Home tab locate the Font group 

o In Font group click the drop-down arrow next to font size box 

o Font size menu appears 

o Select the desired font size with a left click 
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o Select the text and click the increase or decrease font size buttons 

 

 

How to Change Font Style in MS Word 

The basic steps to change the font of a text in a document are given below; 

o Select the text you want to modify 

o Select the Home tab and locate the Font group 

o Click the drop-down arrow next to font style box 

o Font style menu appears 

o With a left click select the desired font style 

o If you want to change the font to bold oritalic , click the 'B' or 'I' icons on the format bar. 



43 
 

 

 

How to Change Text Alignment in MS Word 

You can change the text alignment in your document to make it more presentable and 

readable. The basic steps to change the text alignment are given below; 

o Select the content you want to modify 

o In Home tab locate the Paragraph group 

o It has four alignment options ; 

Align Text Left: Aligns the text towards left margin 

Center: Brings the text at centre 

Align Text Right: Aligns the text towards right margin 

Justify: Aligns the text to both left and right margins 

o Select the desired alignment option with a left click 
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How to Create Bulleted and Numbered Lists 

Bullets and numbers are used to make a list more presentable and readable. A bulleted 

list attracts more than a simple list. Word offers you various styles of bullets and 

numbers. The steps to create bulleted lists are given below; 

o Select the text you want to convert to bulleted or numbered list 

o Select the Home tab 

o In Paragraph group click the Bullets or Numbering command 

o It displays Bullets or Numbering menu 

o With a left click select the desired Bullet or Numbering style 

o To increase the list place the cursor at the end of list and press Enter key 
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How to Increase or Decrease the Indent level of the 

paragraph 

To increase or decrease the indent level 

1. Select one or more paragraphs that you want to adjust. 

2. Go to Home and then select the Paragraph dialog box launcher. 

3. Choose the Indents and Spacing tab. 
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How to Create a Table in MS Word 

Table is a versatile tool of MS Word. It allows you to organize your information, i.e. you 

can align text, present numerical data and create forms and calendar. The steps to insert 

table are given below; 

o Place the cursor where you want to insert the table 

o Select the Insert tab 

o In Tables group click the Table command 

o It displays different options to insert the table 

o Select the desired option to insert the table 
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EXERCISE 

1. Explain any five commands of Office button. 

2. What does a title bar display ? 

3. Explain Home Tab, Insert tab and Page Layout tab. 

4. What is a ruler ? 

5. What are different shortcuts for selecting text ? 

6. What is default font size of any document ? 

7. What do you mean by bullets and numbers ? 

8. What is a table ? How to create a table in MS Word ? 
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CHAPTER – 7 

MS Paint - Advanced 

Learning Objectives 

Students will be able to :  

 Explain different tabsof MS Paint 

 Use Text tool, Color Picker Tool, Eraser Tool , Pencil Tool 

 Explain different views 

 Use different shapes 

 use color palette 

 
 

 

In class II, you must have learnt how to draw lines and shapes, how to fill 

the shapes with different colors. In this chapter you are going to use 

various tools like Font, color, eraser, pencil. Also we will discuss Home Tab 

and View Tab and their commands 

Home tab: 

The Home tab is the default tab in Microsoft Paint It has five groups of related 

commands; Clipboard, Image, Tools, Shapes and Colors.. It also helps you to return to 

the home section of the document. 

 

Tools Group 

Hello  Friends.  

In this chapter, we are going to discuss 

more about MS Paint and its tools 
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The Tools group contains six drawing tools 

 

 

 

  

 

 

 

 

 

 

1. TEXT Tool 

In order to type message in Paint, we can use the Text tool. To type a text, follow the 

given steps : 

Step 1. Click on Home tab 

Step 2. Select the Text tool from the Tools group 

Step 3. Bring the pointer to the drawing area. Click where you want to add the text. A 

textbox will appear 

Fill with color 

 
   Text 

 

Brushes 

 

Magnifier 

 

Color Picker 

  Eraser 

  Pencil 
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`  

 

 

2. Color Picker Tool 

This tool is used to pick an exact color from any image and that color can be used to fill 

color anywhere on the drawing area. 

Follow these steps to use this tool 

1. Draw any two shapes in the drawing area and fill different colors in them. For 

example a Red Circle and a Green Diamond 

2. Select the color picker tool from the tools Group 
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3. Bring the pointer to the Green Diamond to pick the green color. The shape of the 

pointer will change. 

4. Now move the pointer inside the Red Circle and click once. 

5. The color of the circle will change to green. 

 
 

 

3. Eraser Tool  
Rubber tool is used to erase the part of the picture. When you erase a portion it will 

be filled with the default background color chosen. 

 

Follow these steps to use this tool 

1. Select the Eraser tool from the tools group  

2. Select the part of the image to be erased. 
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3. Drag the mouse over the image of which you want to erase the part by background 

color. 

4. For example White eraser and Red eraser to erase the parts of  circle and 

Diamond respectively. 

 

4.  

4. Pencil Tool 

This tool is used to write the free hand text with selected background color. 

Follow these steps to use this tool 

1. Select the Pencil tool from the Tools group. 

2. The Pencil tool will have default color 

3. Click on the drawing area to use this tool. 

4. Write the message you want to add. For example Circle and Diamond have been 

written on the drawing area with Red color. 
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View Tab : 

This is the Second Tab of MS Paint. It has three groups of related commands. Zoom, 

Show or hide and Display. 

 

 

The View menu contains commands that are used to change the way the image or workspace 

are presented. These commands do not alter the image itself, only the way it is displayed. 
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 Zoom In 

This zooms in on the image. This has the appearance of magnifying it.  The amount of 
magnification is increased in fixed steps (e.g., 100%, 200%, 300%,  etc.) 

 Zoom Out 

This zooms out from the image. This has the appearance of reducing the image or 
viewing it from further away.  The amount of zoom reduces in fixed steps The amount of 
magnification is  decreased in fixed steps (e.g., 100%,  50%, 25%, 12.5%....). 

 

 100 % 

This sets the zoom level to 100%. Each pixel on the screen will correspond exactly with 
one pixel in the active layer. 
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 Full Screen 

This command zooms the image to the limits of the Editing Window or to full size. 

If the image is larger than the Editing Window at 100%, it will be reduced to fit within 
the Editing Window.  If the image is smaller than the Editing Window at 100% it will be 
shown full size. 

 

 

Shapes Group 

MS-Paint shapes are used to create shapes. The 

shape tool includes 23 predefined shapes: six 

basic shapes, six polygon or star shapes, four 

arrows, three callout shapes, and two symbols. 

The various shapes can be selected from the 

shapes group. 



56 
 

 

 

 

 

 

 

 

Outline and Fill Shapes 

This tool is used to provide outline and fill any shape with different shades of colors. 

Some of the options available are 

No fill , Solid Color, Crayon, Marker, Oil, Natural Pencil and  Watercolor 

 

 

Solid Color Crayon         Marker        Oil      Natural Pencil Watercolor 

Colors In MS Paint 

The Color section of the ribbon has three parts: 

1. Boxes; showing the active colors-Color 1 and Color 2  

2. The Color Palette  

3. The Edit Colors button.  
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1. Color Box : 

Color 1 : Color 1 is the Foreground Color and is always black when we open Paint.  

Color 2 : Color 2 is the Background Color and is always white when we open Paint.  

2. The Color Palette : The two top lines of the Color Palette show all the colors 

available. Whenever we are making a picture. The line of blank squares at the bottom 

shows those colors we have edited during our work. Once Paint is closed, the edited 

colors vanish away.  

3. Edit Colors : The Edit Colors button takes us into the Edit Colors dialog box. We can 

click any color on an extended palette and click the Add to Custom Colors button. Here 

only one color will be added to the squares under the palette. To add more colors, we 

must return to the dialog box and add them one at a time. 
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Projects –  

During your practical classes, students can draw Design of a house, Scenery, school 

building, machine, cartoon character, etc. 

 

EXCERISE 

Q1. Fill in the blanks. 

 

11) ___________ Color and is always black when we open Paint. 

12) Zoom in is used to _________ the image. 

13) __________ is used to write the free hand text. 

14) Rubber tool is used to ________ the part of the picture. 

Q2. Answer the following questions. 

1. Name any four drawing tools. 

2. Describe the steps that you need to follow to type a text in paint. 

3. Why do we use color picker tool? 

Q3. Write ‘T’ for true and ‘F’ for false. 

1. Home tab helps you to return to the home section of the document.     ________ 

2. The shape tool includes 23 predefined shapes.    __________ 

3. The Pencil tool do not have default color.    _________ 

4. Background Color and is always black when we open Paint.            __________ 

 

 

 

 

 

 

 

 

 

Erase, pencil tool, foreground, magnify  
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CHAPTER – 8 

Programming with LOGO – Part 1 

Learning Objectives 

Students will be able to :  

 Start LOGO 

 Understand what a Turtle is 

 Control the Turtle 

 Change the color of the Pen 

 Draw different trigonometric shapes 

 

 

 

 

Logo is a programming language that is very simple and easy to learn. The full 

form of LOGO  isLanguageOf a Graphics Oriented. Logo was developed in the 

late 1960s at Bolt Beranek and Newman, Inc., in Cambridge, by W. Feurzeig, D. 

Bobrow and S. Papert. Its purpose was to teach children to program. Its main 

feature is that it provides simple commands for moving a ``turtle'' on a surface. 

Why should we learn the Logo language? 

 Because it is fun, lots of fun. 

 Enhances the logical sense of the children. 

 Develops programming skills. 

 It is real Computer Science. 

 Logo is a very easy and interesting programming language to learn. It has 

enough depth to virtually do anything, which can be done in any other 

computer programming language. 

Hello  Friends.  

In this chapter, we are going to discuss 

about Programming using LOGO 
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 Logo can be used to do the following tasks: 1. Draw figures 2. Type Text 3. 

Solve mathematical problems 

 

How to download and install MSW Logo Software?  

If Logo Programming Software is not installed on the computer, we can get it for 

free from the following link − 

www.softronix.com/mswlogo.html 

After installation, it puts Logo icon on the desktop of your computer. 

 

The MSW Logo screen has two parts − 

 A Drawing window above with a triangle-shaped TURTLE in the center. 

 A Commander window as shown in the following screenshot. 

 

http://www.softronix.com/mswlogo.html
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The Logo turtle has two parts 1) Head 2) Tail. The top pointed end of the turtle  is 

called its head., whereas the wide base at the turtle’s bottom is called its tail. 

We write commands in the command line, i.e., the text box at the bottom of the 

Commander Window. These commands are called primitives. 

The commander window is divided into three parts. 1. Command input box 2. 

Recall list box 3. Command Buttons. To execute or run these commands, press 

Enter or click the Execute Button. 

Logo - Turtle 

The simple Logo Drawing Commands move the Turtle forward and backward and 

also turn it right or left. LOGO language is not case sensitive. Command in 

uppercase or lowercase has same effect. The commands and their abbreviations are 

given below − 

 fd – forward 

 bk – backward 

 rt – right turn 

 lt – left turn 

 cs – clearscreen 

Except the cs command, each of these commands must be followed by one value 

called as its argument. The arguments for fd and bk are units; those of rt and lt are 

angles that can be any integer. 

For example 

FD 50 or Forward 50 means move he turtle 50 steps 

BK 20 or back 20 means move the turtle 20 steps 

RT 90 or Right 90 means move the turtle 90 degrees towards right 

LT 90 or Left 90 means move the turtle 90 degrees towards left 

CS means clear the screen 

Let us try some of these commands and see their outputs 

FD 50  
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FD 50 RT 90  

 

FD 50 RT 90 FD 50  

 

FD 50 RT 90 FD 50 LT 90 

FD 50 RT 90 FD 50 LT 90 FD 50  

 

FD 50  RT 90 FD 50 LT 90 FD 50 RT 90 FD 50 RT 90 FD 250 

 

Logo - Controlling the Turtle & Pen 

Logo has a number of other drawing commands, some of which are given below. 

 pd – pendown 
 pu – penup 
 ht – hideturtle 
 st – showturtle 
 setpensize 

The pedown and penup commands tell the turtle to leave ink on the screen as it moves 
or not to leave ink, respectively. The hideturtle and showturtle commands hide or 
show the turtle, but do not affect its ability to leave ink as it moves.  

For example : 

fd 50 penup fd 50 pendown fd 50 rt 90 fd 50 penup fd 50 pendown 

fd 50  rt 90 fd 50 penup fd 50 pendown fd 50 rt 90 fd 50 penup 

fd 50 pendown fd 50 hideturtle 

 

Output :-  
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SETPENSIZE :This command allows you to increase or decrease the size of the 

pen 

SETPENSIZE [2 2]  FD 50 SETPENSIZE[3 3] RT 90 FD 50 

SETPENSIZE[4 4] RT 90 FD 50 SETPENSIZE[5 5] RT 90 

RT 180 FD 50 LT 90 SETPENSIZE[6 6] FD 50 

HIDETURTLE 

SETPENCOLOR 
This command determines Pen color according to the number  

CS SETPENCOLOR 1 FD 50 SETPENCOLOR 2 RT 90 FD 50 SETPENCOLOR 3 RT 

90 FD 50 SETPC 4 RT 90 FD 50 

 

SETPENCOLOR 1  BLUE 

SETPENCOLOR 2 GREEN 

SETPENCOLOR 3  CYAN 

SETPENCOLOR 4 RED 

PENERASE 

This command turns the turtle's pen into an eraser. When the turtle moves, it appears to 

erase by drawing in the current background color. To stop PENERASE, 

use PENDOWN, PENUP or SETPEN. 

 

fd 50 setpensize[5 5] fd 50  

 

rt 180   

 

penerasefd 20 

 

REPEAT  
Let us try to draw a square 

CS 
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fd 100rt 90fd 100rt 90fd 100rt 90fd 100rt 90 
hideturtle 
 
The output would be  
We note that the two commands – fd 100 and rt 90 are repeated four times. Will it not 

be simpler to tell the computer that it should just repeat these two commands four times 

instead of writing them four times in a row? We can do exactly this, using the following 

command – 

To draw a Square  

cs 
repeat 4[fd 100 rt 90] 
hideturtle 
 

 

To draw a Triangle  

cs 
repeat 3[fd 100 lt 120]  
hideturtle 
 
 

 

To draw a Circle  

cs 
repeat 36[fd 10 lt 360/36] hideturtle 
 
 
 

 

Draw Letters :- Let us try to draw some of the English letters 

For example Letter  A 

cs 

rt 13.5fd 200rt 148.5fd 200bk 100rt 108fd 55 

 

Letter B 

cs 

rt 90 , repeat 180[fd 1 lt 1],  rt 180,  repeat 180[fd 1 lt 1] , lt 90 , fd 229 

You can try other letters using Logo 

 

Hope, you must have learnt a bit of programming using LOGO  
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EXCERCISE 

1. What is the full form of logo? 

2. What is the shape of a turtle?  

3. How many parts of logo windows?  

4. Name the two main parts of logo windows.  

5. How many parts of logo turtle?  

6. What is meant by head and tail of the turtle?  

7. What is another name of logo commands?  

8. Where do we type the commands? 

9. Who developed the MSW logo?  

10. from which website, we can download MSW logo?  

11. In how many parts the commander window is divided? Name them.  

12. Write the steps to start logo.  

13. Write the three uses of logo. 

14. Which command do we use to clear the screen? 

15. How can we make the turtle reappear on the screen? 

What is the meaning of bk 100 in Microsoft Windows Logo?  

16. Write the command to draw a shape of square.  

17. Write the command to draw a star. 

18. Write the command to draw T-shape. 

19. Write commands to draw picture of Upward staircase ( Steps). 

20 Write commands to draw English Letters E, H, K, L , O 


